
PSoC™ 6 CY8CPROTO-063-BLE with AIROC™

Bluetooth® LE Prototyping Board user guide

About this document
Scope and purpose

Thank you for your interest in the CY8CPROTO-063-BLE PSoC™ 6 Bluetooth® LE Prototyping Board.
The CY8CPROTO-063-BLE PSoC™ 6 Bluetooth® LE Prototyping Board is designed as an easy-to-use and
inexpensive prototyping platform. The CY8CPROTO-063-BLE Prototyping Board includes the AIROC™

CYBLE-416045-02 Bluetooth® LE module, delivering a complete system solution for a wide range of embedded
applications at a very low cost.
In addition, the board includes the following features:
• Two LEDs to provide feedback
• A push button to provide a simple user input
• Footprint for external ECO (2.0 mm × 1.6 mm, 24 MHz)
• External WCO (32.768 kHz)
• 1.8 V to 3.3 V operation
Intended audience

This document is intended for users interested in the PSoC™ 6 Bluetooth® LE Prototyping Board.
Evaluation board

This board is to be used during the design-in process for evaluating and measuring characteristic curves, and
for checking datasheet specifications.

Note: PCB and auxiliary circuits are NOT optimized for final customer design.
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Important notice
“Evaluation Boards and Reference Boards” shall mean products embedded on a printed circuit board
(PCB) for demonstration and/or evaluation purposes, which include, without limitation, demonstration,
reference and evaluation boards, kits and design (collectively referred to as “Reference Board”).
Environmental conditions have been considered in the design of the Evaluation Boards and Reference
Boards provided by Infineon Technologies. The design of the Evaluation Boards and Reference Boards has
been tested by Infineon Technologies only as described in this document. The design is not qualified in
terms of safety requirements, manufacturing and operation over the entire operating temperature range
or lifetime.
The Evaluation Boards and Reference Boards provided by Infineon Technologies are subject to functional
testing only under typical load conditions. Evaluation Boards and Reference Boards are not subject to the
same procedures as regular products regarding returned material analysis (RMA), process change
notification (PCN) and product discontinuation (PD).
Evaluation Boards and Reference Boards are not commercialized products, and are solely intended for
evaluation and testing purposes. In particular, they shall not be used for reliability testing or production.
The Evaluation Boards and Reference Boards may therefore not comply with CE or similar standards
(including but not limited to the EMC Directive 2004/EC/108 and the EMC Act) and may not fulfill other
requirements of the country in which they are operated by the customer. The customer shall ensure that
all Evaluation Boards and Reference Boards will be handled in a way which is compliant with the relevant
requirements and standards of the country in which they are operated.
The Evaluation Boards and Reference Boards as well as the information provided in this document are
addressed only to qualified and skilled technical staff, for laboratory usage, and shall be used and
managed according to the terms and conditions set forth in this document and in other related
documentation supplied with the respective Evaluation Board or Reference Board.
It is the responsibility of the customer’s technical departments to evaluate the suitability of the
Evaluation Boards and Reference Boards for the intended application, and to evaluate the completeness
and correctness of the information provided in this document with respect to such application.
The customer is obliged to ensure that the use of the Evaluation Boards and Reference Boards does not
cause any harm to persons or third party property.
The Evaluation Boards and Reference Boards and any information in this document is provided "as is"
and Infineon Technologies disclaims any warranties, express or implied, including but not limited to
warranties of non-infringement of third party rights and implied warranties of fitness for any purpose, or
for merchantability.
Infineon Technologies shall not be responsible for any damages resulting from the use of the Evaluation
Boards and Reference Boards and/or from any information provided in this document. The customer is
obliged to defend, indemnify and hold Infineon Technologies harmless from and against any claims or
damages arising out of or resulting from any use thereof.
Infineon Technologies reserves the right to modify this document and/or any information provided
herein at any time without further notice.
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Safety precautions

Note: Please note the following warnings regarding the hazards associated with development systems.

Table 1 Safety precautions

Caution: The evaluation or reference board contains parts and assemblies sensitive to
electrostatic discharge (ESD). Electrostatic control precautions are required when installing,
testing, servicing or repairing the assembly. Component damage may result if ESD control
procedures are not followed. If you are not familiar with electrostatic control procedures, refer
to the applicable ESD protection handbooks and guidelines.

Caution: A drive that is incorrectly applied or installed can lead to component damage or
reduction in product lifetime. Wiring or application errors such as undersizing the motor,
supplying an incorrect or inadequate AC supply, or excessive ambient temperatures may
result in system malfunction.

Caution: The evaluation or reference board is shipped with packing materials that need to be
removed prior to installation. Failure to remove all packing materials that are unnecessary for
system installation may result in overheating or abnormal operating conditions.
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1 Introduction
PSoC™ 6 MCU is a programmable embedded system-on chip, integrating custom digital peripheral functions,
memory, and both an Arm® Cortex®-M0+ CPU and Cortex®-M4 CPU on a single chip with flexible automatic
routing. Programmable digital peripheral functions allow higher flexibility, in-field tuning of the design, and
faster time-to-market. It is a combination of MCU with standard communication and timing peripherals, and a
capacitive touch sensing system with best-in-class performance.
The CY8CPROTO-063-BLE PSoC™ Bluetooth® LE Prototyping Board offers an open footprint breakout board to
maximize the end utility of the PSoC™ 6 MCU with Bluetooth® Low Energy Connectivity (PSoC™ 63 Line) device.
This kit provides a low-cost alternative to device samples while providing a platform to easily develop and
integrate the PSoC™ 6 MCU into your end-system.
The CY8CPROTO-063-BLE PSoC™ 6 Bluetooth® LE Prototyping Board also integrates Infineon KitProg3 that
enables onboard programming, debugging, and bridging functionalities, such as USB-UART and USB-I2C.
KitProg3 is used to program and debug the target PSoC™ 6 MCU which is part of the Bluetooth® LE Module (see
Figure 1). The Prototyping board allows you to separate the KitProg3 board from the target PSoC™ 6 Bluetooth®

LE board.

1.1 Kit contents
The CY8CPROTO-063-BLE PSoC™ 6 Bluetooth® LE Prototyping Kit contains PSoC™ 6 Bluetooth® LE Prototyping
Board (which contains AIROC™ CYBLE-416045-02 Bluetooth® LE module), USB 2.0 Type-A to Micro-B Cable and
Quick Start Guide.

Figure 1 CY8CPROTO-063-BLE PSoC™ 6 Prototyping Board - Top view

Figure 2 CY8CPROTO-063-BLE PSoC™ 6 Prototyping Board - Bottom view
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2 ModusToolbox™

ModusToolbox™ is a free software development ecosystem that includes the Eclipse IDE for ModusToolbox™,
AIROC™ BTSTACK, Bluetooth® SDK, and the PSoC™ 6 SDK to develop applications for Infineon IoT products.
Eclipse IDE for ModusToolbox™ is a multi-platform, integrated development environment (IDE) used to create
new applications, update application code, change middleware settings, and program or debug applications.
Using ModusToolbox™, you can enable and configure device resources and middleware libraries, write C source
code, and program and debug the device. The build system infrastructure includes the new project creation
wizard that can run independently of the Eclipse IDE, the make infrastructure, and other tools. This means you
can choose your compiler, RTOS, and ecosystem without compromising usability or access to our industry-
leading CAPSENSE™ (Human-Machine Interface), AIROC™ Wi-Fi and Bluetooth®, security, and various other
features.
The Infineon’s AIROC™ BTSTACK is a software implementation of the Bluetooth® core 5.4 host protocol stack.
The stack is hosted as a library on Infineon’s GitHub. The stack library includes both Bluetooth® BR/EDR and
Bluetooth® Low Energy hosts and provides APIs for them. The application can choose to use Bluetooth® Low
Energy or both BR/EDR + LE. The stack is available for different Arm® cores, such as CM4 and CM33, and can be
used with three toolchains Arm®, GCC, and IAR.
For more details on ModusToolbox™ installation and usage, see the ModusToolbox™ user guide

2.1 ModusToolbox™ code examples
ModusToolbox™ includes many code examples. Many of these code examples are compatible with this kit.
Browse the collection of starter applications during application setup through File > New > ModusToolbox™

Application or browse the collection of code examples on Infineon’s GitHub repository.

2.1.1 Create a new application
This part takes you step-by-step through creating a new ModusToolbox™ application. Before performing the
steps in this section, decide whether you want to create and run the code example as-is or you would instead
learn how to create an application from scratch. Depending on your choice, the steps you need to follow are as
shown below:

Path “Using CE directly” path (Evaluate existing
code example (CE) directly)

“Working from Scratch” path (Use existing
code example (CE) as reference only)

Actions Follow the sections Select a new workspace,
Create a new ModusToolbox™ application, Select
PSoC™ 63 MCU-based target hardware, and
Create the Bluetooth® LE Find Me code example
(applicable only for the “Using CE directly” flow).
Ignore section Select a starter application and
create the application (Applicable only for
“Working from Scratch” flow).

Follow the sections Select a new workspace,
Create a new ModusToolbox™ application,
Select PSoC™ 63 MCU-based target hardware,
and Select a starter application and create the
application (Applicable only for “Working from
Scratch” flow).
Ignore section Create the Bluetooth® LE Find Me
code example (applicable only for the “Using CE
directly” flow).

Launch ModusToolbox™ and get started.

2.1.1.1 Select a new workspace
At launch, ModusToolbox™ presents a dialog to choose a directory for use as the workspace directory. The
workspace directory is used to store workspace preferences and development artifacts such as device
configuration and application source code.
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You can choose an existing empty directory by clicking the Browse button, as Figure 3 shows. Alternatively, you
can type in a directory name to be used as the workspace directory along with the complete path, and
ModusToolbox™ will create the directory for you.

Figure 3 Select a directory as workspace

2.1.1.2 Create a new ModusToolbox™ application
Click New Application in the Start group of the Quick Panel. Alternatively, you can choose File > New >
ModusToolbox™ Application (Figure 4).
The Eclipse IDE for ModusToolbox™ Application window appears.

Figure 4 Create a new ModusToolbox™ application

2.1.1.3 Select PSoC™ 63 MCU-based target hardware
ModusToolbox™ presents the list of Infineon kits to start your application development. In this case, we want to
develop an application on the CY8CPROTO-063-BLE evaluation board that uses the PSoC™ 63-line device. Select
CY8CPROTO-063-BLE and click Next (Figure 5).
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Figure 5 Choose target hardware

2.1.1.4 Create the Bluetooth® LE Find Me code example (applicable only for
the “Using CE directly” flow)

Here, you Create an existing code example into Eclipse IDE for ModusToolbox™. Use this feature to create the
Bluetooth® LE Find Me code example for the Using CE directly flow. Figure 6 shows the Select Application dialog
of the project creator tool. Select the Bluetooth® LE Find Me application, and optionally, in the ‘New application
Name’ field, change the name of the application. Click on Create and wait for the application to get
downloaded and created in the workspace. Click on Close to complete the application creation process.
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Figure 6 Create Bluetooth® LE Find Me code example

You have successfully created a new ModusToolbox™ application for CY8CPROTO-063-BLE.

2.1.1.5 Select a starter application and create the application (Applicable
only for “Working from Scratch” flow)

Here, you use an existing template application as the starting point for the Working from Scratch development
flow. In the Select Application dialog shown in Figure 7, select Empty_ App. In the Name field, type in a name
for the application and click Next; the application summary dialog appears. Click on Create and wait for the
application to get downloaded and created in the workspace. Click on Close to complete the application
creation process.
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Figure 7 Starter application window

You have successfully created a new ModusToolbox™ application for CY8CPROTO-063-BLE.

2.1.1.6 Programming and debugging using ModusToolbox™

You can build and program the application in ModusToolbox™. In the project explorer, select the <App Name>
project. In the Quick Panel, scroll to the Launches section, and click the <App Name> Program
(KitProg3_MiniProg4) configuration as shown in Figure 8.

Figure 8 Programming the CY8CPROTO-063-BLE device using ModusToolbox™
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2.2 Related code examples
The kit code examples are accesses from the GitHub repository. This code example is available in
ModusToolbox™. For the most recent version of the code example, check the GitHub repository. You can find the
CE230297 code example in mtb-example-btstack-freertos-findme. For more details on the functionality, design,
and implementation of the code example, see the Readme file present in the same folder as that of the code
example. To import the most recent version of the GitHub code examples into ModusToolbox™, see the
ModusToolbox™ user guide document (Help > ModusToolbox™ > Documentation > User guide).

2.3 ModusToolbox™ help
Launch ModusToolbox™ and navigate to the following items:
• Quick start guide: Choose Help > Eclipse IDE for ModusToolbox™ Documentation > Quick start guide.

This guide gives you the basics of using ModusToolbox™

• ModusToolbox™ General Documentation: Choose Help > ModusToolbox™ General Documentation >
ModusToolbox™ Documentation Index. This page provides links to various ModusToolbox™ documents

• ModusToolbox™ User guide: Choose Help > Eclipse IDE for ModusToolbox™ Documentation > User
guide. This is a comprehensive guide for creating, building, and programming ModusToolbox™ applications

2.4 Getting started
This guide will help you get acquainted with the CY8CPROTO-063-BLE PSoC™ 6 Bluetooth® LE Prototyping
Board:
• The Kit operation chapter describes the major features of the CY8CPROTO-063-BLE PSoC™ 6 Bluetooth® LE

Prototyping Board and functionalities such as programming, debugging, and the USB-UART and USB-I2C
bridges

• The Code examples chapter describes how to easily adapt a code example that was originally developed
for PSoC™ 6 Bluetooth® LE Pioneer Kit (CY8CKIT-062-BLE)

• The Appendix describes the hardware content of the kit and the hardware operation, details about
programming the kit using MiniProg4, Kit Schematics, and the bill of materials (BOM)

2.5 Additional learning resources
Infineon provides a wealth of data at www.infineon.com to help you to select the right PSoC™ device for your
design, and to help you to quickly and effectively integrate the device into your design. The following is an
abbreviated list for PSoC™ 6 MCU:
• Overview: PSoC™ Portfolio
• Product Selectors: PSoC™ 6 MCU Product Selector
• Datasheets: Describe and provide electrical specifications for the PSoC™ 61, PSoC™ 62, PSoC™ 63 devices

and AIROC™ CYBLE-416045-02 Bluetooth® LE module datasheet
• PSoC™ 4 and PSoC™ 6 MCU CAPSENSE™ design guide: Learn how to design capacitive touch-sensing

applications with the PSoC™ 6 MCU and PSoC™ 4 family of devices
• Reference manual: Provide detailed descriptions of the architecture and registers in each PSoC™ 6 MCU

family
• Development Kits:

- PSoC™ 6 Bluetooth® LE Pioneer Kit (CY8CKIT-062-BLE) and PSoC™ 6 WiFi -BT Pioneer Kit (CY8CKIT-062-
WiFi-BT) are easy-to use and inexpensive development platforms. These kits include connectors for
Arduino compatible shields and Digilent Pmod Peripheral Modules
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- PSoC™ 6 Bluetooth® LE Prototyping Kit (CY8CPROTO-063-BLE) are very low-cost prototyping platform
for sampling PSoC™ 6 MCU

- CY8CKIT-005-A is a common development platform for all PSoC™ family devices
- The MiniProg4 device provides an interface for flash programming and debug

Note: MiniProg4 is not required to use kits such as CY8CPROTO-063-BLE that have KitProg3
provided on-board

• Knowledge Base Articles (KBA): Provide design and application tips from experts on using the device
• ModusToolbox™ Training: Visit ModusToolbox™ for a comprehensive list of video training on ModusToolbox™

• Learning from Peers: Visit community.infineon.com/welcome to meet enthusiastic PSoC™ developers
discussing the next-generation embedded systems on Infineon Developer Community Forums

2.6 Technical support
For assistance, visit Infineon Support.
You can also use the following support resources if you need quick assistance:
• Self-help (Technical documents)
• Local sales office locations
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3 Kit operation
This chapter introduces you to different features of the CY8CPROTO-063-BLE PSoC™ 6 Bluetooth® LE Prototyping
Kit. This primarily includes the programming and debugging functionalities, KitProg3 USB-UART and USB-I2C
bridges, and the procedure to update the KitProg3 firmware.

3.1 Theory of operation

Figure 9 Block Diagram of CY8CPROTO-063-BLE PSoC™ 6 Bluetooth® LE Prototyping Board

The CY8CPROTO-063-BLE PSoC™ 6 Bluetooth® LE Prototyping Kit is simplistic in design and focuses on providing
you with complete access to develop applications using the PSoC™ 6 MCU. This kit supports the following
features:
• PSoC™ 6 Bluetooth® LE I/O Headers: The Prototyping Board brings all GPIOs of the target CYBLE-416045-02

module to the two expansion headers, except the pins used for the WCO crystal. Although this is a subset of
the actual PSoC™ 6 MCU, it is sufficient to evaluate most of the features

• User LEDs: The onboard LEDs, (LED3 and LED4) can be used to display outputs from the PSoC™ 6
Bluetooth® LE device. This includes modulating the brightness of the LED to notify different states of
the device. You may interface other LEDs as well by connecting to the expansion headers directly or by
connecting them to a breadboard

• User Button: This kit has a push button, which can be used to provide an input to the PSoC™ 6 MCU.

Note: The button connects the PSoC™ 6 MCU pin (P0[4]) to ground when pressed. Therefore, you need to
configure the PSoC™ 6 MCU pin as ‘resistive pull-up’ for detecting the button press

• Bluetooth® LE Module: The Bluetooth® LE module (CYBLE-416045-02) from Infineon is used to demonstrate
how easily an end product can be created with Bluetooth® LE. The Bluetooth® LE module contains the
CY8C6347BZI-BLD53 PSoC™ 6 MCU, crystal used for the Bluetooth® LE radio, and an onboard antenna. Most
code examples that work for the PSoC™ 6 MCU will work with the Bluetooth® LE module, depending only on
the GPIO requirements
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• ECO Crystal footprint: A footprint for an external crystal is provided so that you may attach a crystal with
your choice of frequency.
The recommended crystal is ECS-240-8-37CKM from ECS Inc., which provides 24 MHz at ±50 ppm accuracy.
Any crystal with compatible footprint (2.0 mm × 1.6 mm) can be used

• WCO Crystal: A 32.768-kHz crystal is provided and is used for Bluetooth® LE applications to provide
accurate timing including when the device is in low power mode

• Reset Button: This button is used to reset the PSoC™ 6 MCU when pressed
• Power LED: This LED indicates power is being supplied to the board
• 5-pin Programming Headers: These are programming headers that can be used to program the Bluetooth®

LE module using a MiniProg4 programmer/debugger. Typically, this connection is not required because the
kit contains an integrated KitProg3 for programming and debugging

• PSoC™ 5LP I/O Headers: Using these headers, you can evaluate the PSoC™ 5LP (CY8C5868LTI-LP039)
device. The PSoC™ 5LP device is used to implement the KitProg3 functionality by default

• Current Measurement Jumper: Using this jumper, you can measure the current consumed by the
Bluetooth® LE module. This jumper is not populated by default. To use this jumper, you must remove
the zero-Ω resistor R28

• USB 2.0 Micro-B Connector: This connector is used to connect the board to the PC with the provided USB
cable, enable to program and/or debug the device. It is used to provide power to the device

• KitProg3: This is an onboard programmer/debugger utilizing a PSoC™ 5LP device (CY8C5868LTI-LP039),
which enables you to program and debug the target PSoC™ 6 MCU. It can also act as a USB-UART and
USB-I2C bridge.
When used as a standalone module, KitProg3 can be used to program devices of PSoC™ 3, PSoC™ 4, PSoC™

5LP, or PSoC™ 6 families through the SWD interface. This version of the KitProg3 supplies 3.3 volts to the
PSoC™ 6 MCU section of the board. For more details on the KitProg3 functionality, see the KitProg3 user
guide

• KitProg3 Mode Selection Button: This button is used to switch between KitProg3 modes as shown in
Table 2. You can also use this button to provide an input to the PSoC™ 5LP device in custom applications.
Note that the button connects the PSoC™ 5LP pin to ground when pressed. For more details, see the
KitProg3 user guide

• KitProg3 Status LED: This LED gives the programming/mode status of KitProg3

Table 2 KitProg3 Mode Switching

KitProg3 Programming Modes1) Status LED (LED2)

KitProg3 Program/Debug mode (default) ON

CMSIS-DAP Programming mode OFF

3.2 USB-UART Bridge
KitProg3 on the PSoC™ 6 Bluetooth® LE Prototyping Board can act as a USB-UART bridge. The UART lines
between KitProg3 and the target are hard-wired on the board, through the snappable area, with UART_RX
assigned to P5[0] and UART_TX assigned to P5[1] on target PSoC™ 6 MCU. For more details on the KitProg3
USB-UART functionality, see the USB-UART Bridge Feature section in the KitProg3 user guide.

1 Toggling between programming modes can be done by pressing mode switch SW3.

PSoC™ 6 CY8CPROTO-063-BLE with AIROC™ Bluetooth® LE
Prototyping Board user guide
3  Kit operation

User guide 15 002-24993 Rev. *B
2024-09-27

https://www.ecsxtal.com/store/pdf/ecx-1637.pdf
https://www.infineon.com/dgdl/Infineon-KitProg3_User_Guide-UserManual-v17_00-EN.pdf?fileId=8ac78c8c7d0d8da4017d0f01221f1853
https://www.infineon.com/dgdl/Infineon-KitProg3_User_Guide-UserManual-v17_00-EN.pdf?fileId=8ac78c8c7d0d8da4017d0f01221f1853
https://www.infineon.com/dgdl/Infineon-KitProg3_User_Guide-UserManual-v17_00-EN.pdf?fileId=8ac78c8c7d0d8da4017d0f01221f1853
https://www.infineon.com/dgdl/Infineon-KitProg3_User_Guide-UserManual-v17_00-EN.pdf?fileId=8ac78c8c7d0d8da4017d0f01221f1853


KitProg3 PSoC™ 6

P12[6]

P12[7] P5[1]

P5[0]
RXTX

TXRX

Figure 10 UART Connection between KitProg3 and Bluetooth® LE module

3.3 USB-I2C Bridge
KitProg3 can function as a USB-I2C bridge and communicate with the software utility Bridge Control Panel
(BCP). The I2C lines on target Bluetooth® LE module are P6[5] (SDA) and P6[4] (SCL), which are hardwired on
the board to the I2C lines of KitProg3. The USB-I2C bridge supports I2C speeds of 50 kHz, 100 kHz, 400 kHz, and
1 MHz. For more details on the KitProg3 USB-I2C functionality, see the USB-I2C/USB-SPI Bridge Feature
section in the KitProg3 user guide.

KitProg3 PSoC™ 6

P12[0]

P12[1] P6[5]

P6[4]
SCL

SDA

Figure 11 I2C Connection between KitProg3 and Bluetooth® LE module

3.4 Updating the KitProg3 firmware
The KitProg3 firmware normally does not require any update. You can use the PSoC™ Programmer software to
update the KitProg3 firmware if necessary. For a detailed explanation on how to update the KitProg3 firmware,
see Updating KitProg3 in the KitProg3 user guide.
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4 Code examples
This chapter explains the code example to be adapted to the PSoC™ 6 Prototyping Board. Most existing PSoC™ 6
MCU code examples only require the device to be changed and GPIOs to be reassigned to match the board.
All the code examples are available in ModusToolbox™, make sure that you install the Bluetooth® LE module
device support by following the instructions provided in the ModusToolbox™ installation guide.
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A Appendix

A.1 Board details
The PSoC™ 6 Bluetooth® LE Prototyping Board consists of the following blocks:
• Bluetooth® LE module (CYBLE-416045-02)
• PSoC™ 6 MCU I/O headers J1 and J2
• KitProg3 (PSoC™ 5LP) device (CY8C5868LTI-LP039)
• KitProg3 I/O headers J6 and J7
• SWD connection headers J4 and J5
• USB 2.0 Micro-B connector J8
• Power LED, LED1 (amber)
• KitProg3 Status LED, LED2 (amber)
• User LED, LED3 (red)
• User LED, LED4 (green)
• ECO Crystal (footprint)
• WCO Crystal (32.768 kHz)
• One Push Button SW2 (User)
• One Push Button SW1 (Reset)
• One Push Button SW3 (KitProg3 Mode)
• Current Measurement Jumper J3 (foot-print only, shorted by the zero-Ω resistor R28)
• Perforated ‘snappable’ board design
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Figure 12 PSoC™ 6 Bluetooth® LE Prototyping Board pin details

PSoC™ 6 CY8CPROTO-063-BLE with AIROC™ Bluetooth® LE
Prototyping Board user guide
A  Appendix

User guide 19 002-24993 Rev. *B
2024-09-27



A.2 Hardware details

A.2.1 Target board
The target board uses the AIROC™ CYBLE-416045-02 Bluetooth® LE module, which contains a PSoC™ 6 MCU,
CY8C6347BZI-BLD53. PSoC™ 6 MCU is a scalable and reconfigurable platform architecture for a family of
programmable embedded system controllers with both Arm® Cortex®-M0+ CPU and Cortex®-M4 CPU on a single
chip. It combines programmable and reconfigurable digital blocks with flexible automatic routing. The PSoC™ 6
MCU, based on this platform architecture, is a combination of an MCU with digital programmable logic,
programmable interconnect, and standard communication and timing peripherals. The digital subsystems
allow flexibility and in-field tuning of the design. For more information, see the PSoC™ 6 MCU datasheet and the
AIROC™ CYBLE-416045-02 Bluetooth® LE module datasheet.

Figure 13 Schematic of PSoC™ 6 MCU (target)
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A.2.2 KitProg3 board
A PSoC™ 5LP device on the KitProg3 board is used to program and debug the target PSoC™ 6 MCU. The PSoC™

5LP-based KitProg3 connects to the USB port of the PC through the USB 2.0 Micro-B connector and to the SWD
interface of the target Bluetooth® LE module.

Figure 14 Schematic of PSoC™ 5LP (KitProg3)

A.2.3 Power supply system
The power supply system uses 5 V from the USB connector as the input to a voltage regulator on the KitProg3
section of the board. This regulator provides 3.3 V to the PSoC™ 6 MCU by default. Provisions have been added
so that the output can be easily changed to 2.5 V or 1.8 V by adding either R9 or R41 zero-Ω resistors
respectively. You can also connect an external power supply to the board at P6.VDD that is present on pin 20 of
J1 for low-voltage applications.
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Figure 15 Target power supply

A.2.3.1 Optional PSoC™ 6 MCU voltage regulator
If the PSoC™ 6 MCU section of the board is disconnected from the KitProg3 side by breaking the board between
J4 and J5, there are two power options. The first option is to power the board directly with the required voltage
at the target voltage (P6.VDD) on connector J1, pin 20. The other alternative is to load the optional components
for the PSoC™ 6 MCU regulator and apply a voltage at the VIN connector (J2, pin 20). See schematic below for
the PSoC™ 6 MCU regulator.

Figure 16 Optional PSoC™ 6 MCU regulator

Caution: Note that the PSoC™ 6 Bluetooth® LE Prototyping Board does not have any
onboard ESD protection circuitry. Therefore, the power source for the PSoC™ 6 Bluetooth®

LE Prototyping Board must be of high quality to make sure that the board is protected from
any over-current conditions and swapped-power connections.
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A.2.3.2 Measure Bluetooth® LE module current consumption
To measure the Bluetooth® LE module current, follow these steps:
1. Remove the zero-Ω resistor R28 and install a 2-pin jumper in the supplied holes of J3
2. Connect an ammeter across the 2-pin jumper to measure the current to the Bluetooth® LE module
This method can be used either with USB power or with the power supplied to one of the VTARG pins (J5.1 or
J4.1), but NOT when supplying power to one of the P6.VDD pins (J1.1 or J1.20).
After measuring the current consumption, populate resistor R28 or place a shorting jumper across the two
jumper pins for normal operation of the kit.

Notes:
After removing R28, system may have some leakage power such as the following:
1. Communication circuitry between KitProg3 and Target (I2C, UART, SWDIO)
2. Reset switch between KitProg3 and target device along with PSoC™ 6 MCU

A.2.4 Board separation (snapping)
The PSoC™ 6 Bluetooth® LE Prototyping Board consists of a PSoC™ 6 MCU and a KitProg3 board. To separate the
two boards for evaluation or development, break the two boards apart at the built-in perforated edge between
J4 and J5.
The easiest method of separating the two boards is to place the kit on the edge of a table, where the edge of the
table is directly below the perforated edge and the smaller KitProg3 board is off the table edge. Press gently on
the KitProg3 board and snap the two boards apart. If any material is removed from the edge of the boards, use
sheers to clean up the edge of the kit.
After the PSoC™ 6 Bluetooth® LE Prototyping Board is broken into two, the two halves can be reconnected for
programming and debugging by adding connectors at J5 and J6. Also, a Infineon MiniProg4 device can be
connected to a connector at J5 to perform programming and debug.

Figure 17 PSoC™ 6 Bluetooth® LE Prototyping Board broken into two parts

After the PSoC™ 6 Bluetooth® LE Prototyping Board is broken into two, the two halves can be reconnected for
programming and debugging by adding connectors at J5 and J6. Also, a Infineon MiniProg4 device can be
connected to a connector at J5 to perform programming and debug.
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Caution: Once the boards are separated, direct UART and I2C connections between the
Bluetooth® LE module and KitProg3 are lost. This is because the traces connecting the UART
and I2C lines are cut off during the separation. However, you can access KitProg3’s UART
and I2C lines through header J6 and make the following connections to J2.
UART Reconnect:
• J6.7 to J2.16 (PSoC™ 5LP P12.6 to PSoC™ 6 P5.0)
• J6.6 to J2.17 (PSoC™ 5LP P12.7 to PSoC™ 6 P5.1)
I2C Reconnect:
• J6.5 to J2.19 (PSoC™ 5LP P12.1 to PSoC™ 6 P6.5)
• J6.4 to J2.18 (PSoC™ 5LP P12.0 to PSoC™ 6 P6.4)

A.2.5 Header connections
The PSoC™ 6 Bluetooth® LE Prototyping Board supports a number of unpopulated headers on both the KitProg3
and the target PSoC™ 6 MCU sections.

A.2.5.1 Functionality of the J1 and J2 headers (target board)
The target PSoC™ 6 MCU section contains two single inline headers (J1 and J2). These 1×21-pin headers have
0.1-inch spacing and include all of the GPIOs available on the Bluetooth® LE module. Power pins, reference
input and reset signal are also available on these connectors. See Figure 18 for details.
The target headers J1 and J2 are partially compatible with mikroBUS. It supports only 3.3 V operation with Click
Boards, and does not have the reset pin functionality.
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Figure 18 J1 and J2 headers

Table 3 Pin Details of J1 and J2 headers

PSoC™ 6 Bluetooth® LE Prototyping Board GPIO header (J2) PSoC™ 6 Bluetooth® LE Prototyping Board
GPIO header (J1)

Pin Signal Description Pin Signal Description

J2_01 VBKUP2) Backup Power J1_01 P6_VDD2) Power

J2_02 GND Ground J1_02 GND Ground

J2_03 VREF SAR ADC Vref J1_03 RST PSoC™ 6 MCU
Reset

J2_04 P10.6 GPIO J1_04 P12.7 GPIO

J2_05 P10.5 GPIO J1_05 P12.6 GPIO

J2_06 P10.4 GPIO J1_06 P0.5 GPIO

J2_07 P10.3 GPIO J1_07 P0.4 GPIO/User SW2

J2_08 P10.2 GPIO J1_08 P7.7 GPIO/CMOD
(table continues...)

2 P6_VDD and VBKUP should never exceed 3.6 V.
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Table 3 (continued) Pin Details of J1 and J2 headers

PSoC™ 6 Bluetooth® LE Prototyping Board GPIO header (J2) PSoC™ 6 Bluetooth® LE Prototyping Board
GPIO header (J1)

Pin Signal Description Pin Signal Description

J2_09 P10.1 GPIO J1_09 P7.2 GPIO

J2_10 P10.0 GPIO J1_10 P7.1 GPIO/LED4

J2_11 P5.6 GPIO J1_11 P6.3 GPIO/LED3

J2_12 P5.5 GPIO J1_12 P6.2 GPIO

J2_13 P5.4 GPIO J1_13 P9.6 GPIO

J2_14 P5.3 GPIO J1_14 P9.5 GPIO

J2_15 P5.2 GPIO J1_15 P9.4 GPIO

J2_16 P5.0 GPIO/UART_RX J1_16 P9.3 GPIO/SPI-CS

J2_17 P5.1 GPIO/UART_TX J1_17 P9.2 GPIO/SPI-SCK

J2_18 P6.4 GPIO/I2C-SCL J1_18 P9.1 GPIO/SPI-MISO

J2_19 P6.5 GPIO/I2C-SDA J1_19 P9.0 GPIO/SPI-MOSI

J2_20 VIN Input Voltage J1_20 P6_VDD2) Target Voltage
Input

J2_21 GND Ground J1_21 GND Ground

A.2.5.2 Functionality of J4 and J5 headers (KitProg3 to PSoC™ 6 MCU)
The KitProg3 and target boards each contain a 1×5-pin header. These headers provide a physical connection
between the two devices. Specifically, the connection includes the SWD interface, required to program/debug
the target PSoC™ 6 MCU in the Bluetooth® LE module, power, ground, and reset.

Figure 19 J4 and J5 headers

2 P6_VDD and VBKUP should never exceed 3.6 V.

PSoC™ 6 CY8CPROTO-063-BLE with AIROC™ Bluetooth® LE
Prototyping Board user guide
A  Appendix

User guide 26 002-24993 Rev. *B
2024-09-27



Table 4 Pin Details of J4 and J5 headers

KitProg3 header (J4) PSoC™ 6 MCU header (J5)

Pin Signal Description Pin Signal Description

J4_1 VTARG Power J5_1 VTARG Power

J4_2 GND Ground J5_2 GND Ground

J4_3 P12.4 Reset J5_3 XRES Reset

J4_4 P12.3 SWD_CLK J5_4 P6.7 SWD_CLK

J4_5 P12.2 SWD_IO J5_5 P6.6 SWD_IO

When the boards are separated, the KitProg3 board can be used to program any other PSoC™ 3, PSoC™ 4, PSoC™

5LP and PSoC™ 6 family of devices via J4.

A.2.5.3 Functionality of J6 and J7 headers (KitProg3)
The KitProg3 board contains two single in-line headers (J6 and J7). Both are 1×7-pin-headers, used to pull out
several pins of the PSoC™ 5LP device to support advanced features such as low-speed oscilloscope and a low-
speed digital logic analyzer. This header also contains KitProg3 UART and I2C bridge pins that can be used
when the two boards are separated.
The J6 and J7 headers support 100-mil spacing, so you can solder connectors to connect the KitProg3 board to
a development breadboard.

Figure 20 J6 and J7 Headers
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Table 5 Pin Details of J6 and J7 Headers

PSoC™ 5LP KitProg3 Header (J6) PSoC™ 5LP KitProg3 Header (J7)

Pin Signal Description Pin Signal Description

J6_01 P5LP_VDD Power J7_01 GND Ground

J6_02 GND Ground J7_02 P3.0 GPIO

J6_03 P12.5 GPIO J7_03 P3.4 GPIO

J6_04 P12.0 GPIO/I2C_SCL J7_04 P3.5 GPIO

J6_05 P12.1 GPIO/I2C_SDA J7_05 P3.6 GPIO

J6_06 P12.7 GPIO/UART_RX J7_06 P0.2 GPIO

J6_07 P12.6 GPIO/UART_TX J7_07 P0.1 GPIO

A.2.6 PSoC™ 6 Bluetooth® LE Prototyping Board features
Use the following features of the Prototyping Board to perform a quick evaluation right out of the box.
• Two user LEDs connected to GPIO pins for feedback
• User switch for user input
• Jumper for current measurement (when R28 is removed)
• Onboard Bluetooth® LE Antenna
• Onboard reset switch
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Figure 21 PSoC™ 6 Bluetooth® LE Prototyping Board features

A.2.6.1 User button
The target PSoC™ 6 MCU board contains a button connected to the P0.4 pin on the PSoC™ 6 MCU. This button
can be used for general user inputs or for wakeup during Hibernate mode. The buttons connect to ground on
activation (active low) by default. User button (SW2) can be changed to active high mode by changing the zero
resistors shown below.
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Figure 22 User button on the board

A.2.6.2 User LEDs
There are two user LEDs on the board connected to pins P6.3 (red) and P7.1 (green) to allow the user to indicate
an event or mode. The drive is active LOW so the LED will be ON when the GPIO is driven to a ‘0’ and OFF when
driven to a ‘1’.

Figure 23 User LEDs

A.2.6.3 Reset button
When the Reset button (SW1) is pressed, the XRES line of the PSoC™ 6 MCU is pulled to ground, which resets the
target device.
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A.2.6.4 CAPSENSE™ capacitors
There are footprints for three CAPSENSE™ capacitors - one for self-capacitance and one for mutual Capacitance
sensing modes, but only the CMOD capacitor used for self-capacitance mode is loaded. If CAPSENSE™ is not
used but P7.7 is used for a digital or analog function, C32 may need to be removed. See the datasheet on the
CAPSENSE™ component for more information on how to select and use theses capacitors (C30-CINTA, C31-
CINTB, and C32-CMOD).
Note: P7[1] is used for LED4 (green LED) by default. This must be disconnected by removing R37 before

loading C30 for mutual capacitive sensing (CSX).

Figure 24 CAPSENSE™ capacitors

A.2.6.5 System crystals
Two different crystal oscillators inputs are available on the board. The WCO kHz crystal (32.768 kHz) is
populated and is used for Bluetooth® LE timing. Pads for the ECO MHz crystal and load crystals are on the board
so that you can easily select the crystal of your choice. The ECO is optional and only required when the internal
clock must be more accurate than the IMO (Internal Main Oscillator). The internal FLL and PLL help to provide a
wide range of options with either the ECO or IMO. The crystal used for the Bluetooth® LE radio is pre-installed in
the Bluetooth® LE module.

Figure 25 System crystals
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A.2.6.6 Bluetooth® LE module
CYBLE-416045-02 is a fully certified and qualified module supporting Bluetooth® Low Energy wireless
communication. CYBLE-416045-02 is a turnkey solution and includes onboard crystal oscillators, trace antenna,
passive components, and the Infineon PSoC™ 6 MCU.
The Bluetooth® LE module is a scalable and reconfigurable platform architecture. It combines programmable
and reconfigurable analog and digital blocks with flexible automatic routing. CYBLE-416045-02 also includes
digital programmable logic, high-performance analog-to-digital conversion (ADC), low-power comparators, and
standard communication and timing peripherals.
CYBLE-416045-02 includes a royalty-free Bluetooth® LE stack compatible with Bluetooth® 5.0 and provides up to
36 GPIOs in a 14 × 18.5 × 2.00 mm package. CYBLE-416045-02 is a complete solution and an ideal fit for
applications seeking a high-performance Bluetooth® LE wireless solution. See the AIROC™ CYBLE-416045-02
Bluetooth® LE module datasheet.
The module is based on CY8C6347BZI-BLD53 but gives access only to a sub-set of the I/O pins and functionality.
Most PSoC™ 63 code examples can be adapted to run on this module.

A.2.6.7 KitProg3 switch and LEDs
The KitProg3 board contains a push button connected to P1.2 of PSoC™ 5LP. When this button is pressed, it
toggles between KitProg3 mode and CMSIS-DAP mode. For more details, see the KitProg3 user guide.
A power indicator LED (LED1) will turn ON when the board is plugged into an active USB port to indicate that
power is being supplied.
A second LED (LED2) is used to indicate the status of KitProg3. The Amber Status LED (LED2) indicates the
KitProg3 status connected to P1[4] of the KitProg3 PSoC™ 5LP device. See Table 6 for a summary of the status
LED states. For more details on the KitProg3 status LED, see the KitProg3 user guide.

Table 6 LED status for KitProg3 modes

KitProg3 programming modes3) Status LED (LED2)

KitProg3 Program/Debug mode (default) ON

CMSIS-DAP mode OFF

A.3 Programming PSoC™ 6 Bluetooth® LE Prototyping Board using
MiniProg4/KitProg3

The target board provides a provision to program the PSoC™ 6 MCU using MiniProg4 or an external KitProg3 via
the 5-pin SWD header. To do this, connect wires or a 5-pin 100-mil spaced header to J5. The PSoC™ 6 Bluetooth®

LE Prototyping Board supports both power cycle and reset programming modes.

Caution: MiniProg4 can provide up to 5 V at VTARG which will result in permanent damage
of the device. Please make sure that VTARG is in the range 1.8 V to 3.3 V. Ideally, this
configuration is only used when the KitProg3 section is separated.

3 Toggling between programming modes can be done by pressing mode switch SW3.
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Figure 26 Connecting the CY8CPROTO-063-BLE to a MiniProg4

Note: CY8CKIT-005-A MiniProg4 is not part of the PSoC™ 6 Bluetooth® LE Prototyping Board contents and can
be purchased from the Infineon Online Store.
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Acronyms

Table 7 Acronyms Used in this Document

Acronym Definition

ADC Analog-to-Digital Converter

BCP Bridge Control Panel

BLE Bluetooth® Low Energy

BOM Bill of Materials

CE Code Example

CMOD Modulator Capacitor

DAC Digital to Analog Converter

ECO External Crystal Oscillator

ESD Electrostatic Discharge

FLL Frequency Locked Loop

GPIO General-Purpose Input/Output

I2C Inter-Integrated Circuit

IDAC Current DAC

IDE Integrated Design Environment

IMO Internal Main Oscillator

KBA Knowledge Based Article

LED Light-Emitting Diode

PLL Phase Locked Loop

PSoC™ Programmable System-on-Chip

SAR Successive Approximation Register

SCB Serial Communication Block

SRAM Serial Random Access Memory

SWD Serial Wire Debug

TCPWM Timer, Counter, Pulse Width Modulator

UART Universal Asynchronous Receiver Transmitter

USB Universal Serial Bus

WCO Watch Crystal Oscillator
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